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Protein Metrics Suite Software Release Notes 

Byos®, MS/MS Analysis (Byonic™), Peptide Analysis (Byologic®), Chromatogram Analysis (Byomap™), 
Intact Analysis (Intact Mass™), Supernovo™, Footprint™, Oligonucleotide Analysis, HRIM Analysis, and 
Preview™. 

All enhancements are available within Byos. 

Release 2025-12 (v5.12) 

Multi-Protein Quantitation, Byos  

• New Multi-Protein Quantitation-DIA workflow in Byos  

The Multi-Protein Quantitation-DIA workflow, available with Multi-Protein Quantitation workflow 
license, enables the processing of data-independent acquisition (DIA) mass spec data via the 
MPQ pathway. 

 

Data-independent acquisition (DIA) is sometimes preferred over data-dependent acquisition 
(DDA) for its improved quantitative accuracy, reproducibility, and deeper proteome coverage. DIA 
captures fragmentation data for all ions within specific mass ranges, making it more 
comprehensive and less prone to missing low-abundance peptides that DDA might skip, while 
also being more reproducible across multiple samples. 

With this release, the new Multi-Protein Quan-DIA workflow is automatically enabled for users 
that already have the Multi-Protein Quantitation Workflow license! 

Note that this workflow is not yet available in Byosphere Desktop Client.  

Peptide, Byos  

• Added ability to overlay charge states and stack samples in XIC plots 

A new feature has been added to Byos Peptide workflows under Window > Enable Stacked 
Plots - Overlay Charge States. 

This option is the same as Window > Enable Stacked Plots, except for the XIC plot widget where 
XICs with different charge states will be overlayed within the same sample. Users must ensure 
that charge states are combined prior to selecting this option.  
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• Mass error is now included within the isotope plot  

Mass error is now reported in PPM under the M0 label in isotope plots: 

 

HCP, Byonic, MPQ, Byos 

• Users can now attach multiple FASTA files in various workflows  

Added the ability to provide multiple FASTA files in HCP, Byonic, and MPQ workflows. 
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MOBILion, Byos 

• The MOBILion Reader has been updated to v1.12.0 

Proteome Discoverer, Byos 

• The Byonic and Preview Nodes have been updated to support Proteome Discoverer 3.3. 
These nodes can be downloaded from: https://www.proteinmetrics.com/download/proteome-
discoverer-nodes 

Progressive Deconvolution, Intact, Byos 

• New Progressive Deconvolution workflow is now available  

A Progressive Deconvolution workflow is now available as one of the default workflows in 
Byos. This workflow is useful for the identification and relative quantification of intact protein 
species via Progressive Deconvolution.  

 

• Mass XIC value has been added to the Progressive Deconvolution report.  

The XIC AUC value will now be populated in the Byos report for the Progressive Deconvolution.  
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• Added the ability for a user to set the minimum number of consecutive Mass observations 
in Progressive Deconvolution workflow in Byos 

The following advanced command is now available as an option to filter progressive 
deconvolution results: 

[Intact] 

MinConsecutiveObservations = 3 

 

with 3 being the default value.  

Release 2025-10 (v5.11) 

Multi-protein Quantitation, Byos 

• Byos now displays -log probabilities (protein scores) for MPQ data 

Protein Log Probabilities values are now calculated for Multi-Protein Quantitation workflows. 

 

• Optimized persistence of Isotope plot data  

Rather than saving the entire scan, isotope plot persistence has been optimized in Byos v5.11 by 
only saving a small part of MS1 scans to the database for in-silico peptides. This significantly 
reduces the *.bglc and *.mpq file size while still providing ample context around the isotope 
masses in the mz domain. 

• New parameters have been added to the Quant (Byologic) processing node 

The following parameters have been added to the Quant (Byologic) processing node: 

Under In-silico options:  
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a. Align In-silico Peptides (True/False; Default = True)  

b. Tolerance determination (Auto/Manual; Default = Manual for Hotspot and MAM New 
Peak Detection workflows, Auto for all other workflows possessing this node) 

c. If Tolerance determination is = Manual, an additional Alignment tolerance (minutes) 
variable becomes available with the following default values:  

i. Hotspot: 1.0  

ii. MAM New Peak Detection: 0.25  

iii. All other workflows: 0.0  

 

• Users can now group multiple proteins by class or user-defined criterion  

Proteins can now be grouped by class or user-defined category. 

This editing action is audit-logged. Undo/redo is not supported. 

• Updates to parameters within the Quant (Byologic) processing node 

The “In-silico peptides (CSV) parameter has been renamed to “In-silico options (CSV import)” 
within the Charge Variant Analysis with Reconstruction workflow.  

 

Digested Oligonucleotide, Byos  

• Enhanced inspection for Digested Oligo Mapping  

mRNA Oligo Mapping often results in digest products with sequences that map to multiple 
locations on the mRNA, as well as isomeric digest products (which have the same nucleotide 
composition but differ in order). The ability to monitor and filter unique masses/sequences from 
non-unique ones is significantly more critical for oligo mapping compared to peptide mapping. 

To assess uniqueness, we utilize two existing metrics: Sequence occurrence(s) and the Delta 
score. The first metric, Sequence occurrence(s), indicates how many times a digest sequence 
appears within and across intact oligo sequences. The Delta score, on the other hand, helps us 
determine if different sequences of the same mass could explain the MS2 spectrum differently. A 
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Delta score of 0.0 signifies that there is insufficient fragment information to differentiate between 
isomers. 

We categorize oligo uniqueness into three distinct levels, which are color-coded as follows: 

• Green: The most unique category, where Protein occurrence(s) = 1 in 1 and Delta score > 
0.0. 

• Yellow: This category includes rows where Protein occurrence(s) != 1 in 1 and Delta score > 
0.0. Here, we are confident in the sequence assignment but cannot pinpoint the sequence to 
a specific location. 

• Red: This category consists of rows with Delta score = 0.0, indicating that we cannot 
confidently distinguish the reported sequence from other isobaric sequences. 

MS2 spectra are nested under parent rows in the Oligonucleotides table. To quickly view the 
colored rows, users may utilize the ‘Expand rows’ button at the top of the table. 

 

Release 2025-08 (v5.10) 

Reports, Byos  

• New template and tab preset available that support export to GraphPad Prism  

The new template, MPQ_Prism_Ready_Export.rptc, and tab preset, 
MPQ_Prism_Ready_Export.tabc, are now available. The report/tab preset contain a single tab 
titled “Export Prism” comprising of a Pivot Table. This tab shows the report data in a format which 
facilitates exports from Byos to GraphPad Prism. 

Peptide, Byos  

• Users can now apply advanced sample-to-sample XIC alignment and peak detection to 
newly added peptides 

A dialog has been added to the Edit->Insilico Peptides->Add missing via existing peptides 
selection, allowing users the option to apply advanced sample-to-sample XIC alignment and peak 
detection to newly added peptides. 
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• Added option to define third residues for Glycan motifs.  

Users now have the option to define the third residues for Glycan motifs. The default motif in 
default workflows is NXS/T, but users can now add or replace the third residue with other 
residues. This is performed through Glycans>NGlycan Motif (NxS/T/_) in all workflows 
containing the Byonic node excluding the Digested Oligonucleotides workflow. 

 

• Improvements to the Column Filter presets 
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1. The preset name embedded in a given Workflow will not be overwritten; the original 
name of the preset will be maintained as it may indicate the purpose of the filter e.g. 
"Remove XIC AUC is 0". 

2. The Default preset has been made read-only making its name not editable. 

3. Custom tooltips have been added for both Default and Primary presets to help 
distinguish them from each other. 

 

MOBILion, Byos  

• Upgraded MOBILion Reader to v1.11.1 

Multiprotein Quantitation, Byos  

• A new “Inclusion List” field has been added to the MS/MS Identification node in Multi-
protein workflows 

Added a new field called Inclusion list to Multi-Protein Identification and Multi-Protein 
Quantitation workflows under MS/MS Identification>Inclusion. The field can be modified in a 
new Inclusion dialog where the user can enter inclusion values in a dedicated table: 
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Oligo, Byos  

• Updated Wildtype behavior for Digested Oligonucleotide projects 

The first time a Digested Oligo project is created the Wildtype widget will be turned off by 
default. From that point on, their state is controlled by the user and does not affect other projects.  

 

Each subsequent Digested Oligo project will inherit the setting from the previous session; if 
Wildtype was disabled in the previous session, it will remain off when the next Digested Oligo 
project is opened or created. If Wildtype was enabled in the previous session, it will remain 
enabled for the next Digested Oligo document that is opened or created. 

• Byos will now use the Oligo mapping report template for multi doc reports generated from 
Digested Oligonucleotide projects 
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The Oligo mapping template, Blgc_Oligo_Mapping.rptc, will now be used when generating 
multi-doc reports from Digested Oligonucleotide projects.  

• Collison Energy (CE) scan information for MS2 is now available in the MS2 data table 

 

 

Byonic, Byos  

• Byonic can now search FASTA databases with more than 15 million sequences  

Byonic now can search FASTA databases with more than 15 million sequences. When searching 
large FASTA databases, 64 GB of RAM is the minimum amount of memory needed (128 GB 
RAM recommended). Note: Normal and Heavy multicore options are not recommended for 
extremely large fasta database searches. 

Release 2025-04 (v5.9) 

Peptide, Byos  

• Fast XIC will now be enabled during workflow update  

Fast XIC will now be enabled during workflow updates if the feature is not yet enabled. Users will 
be prompted with a dialog asking if they wish to proceed with this step. 
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• Multiple annotations per peak are now allowed in the annotated MS2 spectrum plot 

Multiple annotations can now exist on a single peak within the annotated MS2 spectrum plot.  

• Asymmetric cleavage products have been extended to cleavable crosslinkers (DSBU) and 
MS2 spectra will now be automatically annotated 

Asymmetric cleavage products, Pep+85 and Pep+111, are now made for DSBU-Xlinked peptide 
spectra. These annotations will only be made when DSBU / 196.0848 @ K | xlink is specified in 
the Project Creation parameters.  

• Improved fragmentation labels for disulfide neutral losses 

Annotation of neutral loss fragment ions, including Pep-NH3, Pep-SH2, and Pep-SCH2, from 
dissociated peptides following ExD fragmentation of crosslinked precursors are now available in 
MS2 plots. 

• Added ability to add pdb file into report during workflow setup 

Users can now add a pdb file into their report during Project Creation for Peptide-level workflows.  
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Glycans, Byos 

• Improvements in glycan fragmentation annotation 

Sources of error in peak annotation are generally higher in glycan spectra compared to other 
biomolecule types since possible fragments are more likely to differ by just 1 or 2 Daltons. The 
glycan fragment annotation tool has been updated to prevent against annotation of +1, +2, etc. 
isotope peaks in glycan MS2 spectra. 

• Enhanced customization of the N-glycan motif to consider non-canonical N-glycosites is 
now available 

Customization of the N-glycan motif to consider non-canonical N-glycosites is now available. This 
is done by entering allowed_third_letters_in_nglycan_motif=[x] into the Byonic 

modifications field, where [x] is a string of amino acid letters that are allowed in the +2 position. 
For example, using allowed_third_letters_in_nglycan_motif=STC, Byonic will search 

for that N-glycan mods only in cases where there is the motif NX{S/T/C}. 

 

 (Data is from doi.org/10.1186/s12967-024-05000-5) 

General, Byos 

• Shimadzu reader has been upgraded to IoModule.4.2.0.7552 
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Note: Readers supplied to Protein Metrics by mass spectrometry manufacturers are used as-is, 
without alteration. Any issues can be reported directly to the manufacturer with Protein Metrics 
support in cc. 

Reports, Byos 

• Users can now export XY data from traces within Byos Reports 

Users can now export the underlying XY data from Trace plots within their Byos report. Doing so 
will provide the X and Y values needed to create the trace plot shown within a CSV file. Note that 
this export will not contain any integration information – users can export XY data for specific 
fragments directly from the Project by right-clicking on the plot of interest, clicking Export to CSV, 
and selecting Yes when asked to use current plot segment. 

 

Multi-Protein Quantitation, Byos 

• Multi-Protein Identification reports will not be generated by default 

The Multi-Protein Identification report will not be generated upon project creation by default—
users can now generate the report manually once the project has been loaded. 

• Enable sample-to-sample XIC alignment added and set to default within Multi-Protein 
Quantitation processing nodes 

A new sample-to-sample XIC alignment parameter is now enabled by default to improve XIC 
RT bounding for in-silico peaks added by the Match Between Runs parameter. Disabling this 
feature could reduce overall processing time by 10% or more, but the XIC RT bounding 
improvements will not be applied. 
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• New option to restrict Match Between Runs within condition 

Users can now apply Match Between Runs between all samples (default) or within each condition. 
This mode is available under the Match between runs tab in the Processing Nodes for the Multi-
Protein Quantitation workflow. 

 

• Updated Multi-Protein Quantitation workflows to have a default autodecoy value of 100 

The default value for ‘auto decoys’ has been updated to 100 in the MPQ workflow.  

 

• Users will now be informed if trying to start an MPQ analysis from a merged Byrslt file 

Added a pre-flight check for all workflows containing “MS/MS search” column that prevents using 
.byrslt file created using a merged byspec2 file. 
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• Multi-Protein Preview analyses now create Byos temp and preset files within the target 
output folder 

Temporary folders are now created in the output directory for Preview-like workflows.  

• The Multi-Protein Quantitation workflow will now preferentially use unique peptides for 
quantitation when there are proteins that share the same peptides(s) as part of their ID 

In the Multi-Protein Quantitation workflow, peptide prioritization for TopN will now proceed using 
the following logic:  

o Prioritize distinct peptide sequences (preferring a peptide ranked lower by AUC over a 
duplicate sequence with different modification). 

o Prioritize peptides that are more abundant per charge. Thus, abundance of a peptide 
with regards to TopN is not the maximum per-charge average abundance (previously, 
average abundance across all charges). 

Preview, Byos 

• Preview has been added to the Byos homepage as a standalone workflow 

Preview is a standalone desktop application that performs a first-pass, prospecting style search to 
identify key parameters that can subsequently be used for Byonic peptide search. Mass errors, 
digestion specificity, and common modifications are among the parameters that Preview will 
suggest. This update allows users to access the tools of Preview within a Byos workflow. 



18 

 

• Preview now supports Waters raw files 

The standalone Preview application can now accept Waters raw data as an input. 

icIEF-MS, Byos 

• Labels are now automatically applied to Deconvolved icIEF-MS plots 

Labels on the Deconvolved Mass plot are now rendered for icIEF-MS projects, with the 
functionality now the same as in Intact (.ntms; .olms) workflows. 

 


